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Introducing
Gemstar eBook Publisher

Gemstar eBook Publisher™ is a professionsl tool for publishing
electronic books, Using Gemstar eBook Publisher, you can
convert books, periodicals, and other documents into eBook

Editions™, electronic hooks that can be read on Gemstar

eBook™ devices, Gemstar eBook Publisher is one part of a
complete paperless publishing and distribution system that
consists of!

+ Gemstar's lightweight, portable reading devices for
electronic books,

+ Gemstar eBook Publisher, an Open eBook-compliant
publishing tool for converting books into eBoolk Editions,

+ Distribution, through the Gemstar eBookstore™ or other
online methods,

The following sections in this introduction describe the nesw
features of Gemstar eBook Publisher 2.1 and summarize the
eBook publishing process, If you are new to Gemstar eBook
Fublisher, we recommend that yvou read through these brief
sections to get an overview of the process before going on to
the sections on installing and using the software,

New features

Gemstar eBoolk Publisher 2.1 as a successor to Gemstar eBook
Fublisher 2.0 adds the following major features:

+ The confusion between Edition ID and [SBN has been
removed and the Edition Settings dialo g now validates the
[SEN if entered.

+ The Edition ID has been replaced by a Unique Edition [D
which is automatically generated by the software,
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When editingviewing OEBFF files, you now have an option to
Unpachk the OEBFF onto the file system and edit it as a
nottal project which allows you full access to the document
files,

As a successor to SoftBook Professional Publisher™ 1.5, this
version adds the following major features:

Gemstar eBook Publisher can preview and build eBook
Editions for Color VGA, Grayscale Half-VGA, and Moneochrome
Half-VGA reading devices. [n addition, it can build an OEBFF:
All Targets edition, which produces an OEBFF (Open eBook

File Format) Container file,

A single project can now include all QEB document files,
image files, and style sheet files needed to create editions for
all targets, including alternate files (called fallbachs)
optitmized for specific targets. From this one project, you can
create eBook Editions for any target,

A new tabbed interface in the Project window allows you to
manage all OEB document files, image files, and style sheet
files for the project in a single windowr,

Gemstar eBook Publisher can import Microsoft® Word and
RTF iRich Text Format) documents directly, translating them
into OEB-coded document files that can be added to existing
projects or used to creste new projects,

An expanded Edition Settings window with a tabbed
interface allows you to enter and edit complete publication
information, including title, suthor, [SBN, publisher, imprint,
copyright and publication dates, descriptions, language,
keywords, currency and pricing data, and more,

L]
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Aboutthe Open eBook specification

The Open eBook (OEB) specification defines a standard for the
structure and formatting of electronic hooks that may be
viewed on a variety of reading devices, Based on HTML,
Cascading Style Sheets (C55), and XML, Open eBook markup
will be immediately familiar to anyone acquainted with
standard HTML and CS58 markup. Open eBook markup is
defined in the Open eBook Publication Structure, a copy of
which is included in the Gemstar eBook Publisher folder
installed on yvour computer. This document is also available
through the Open eBook web site (http /v openeboolk.org).

By relying on the Open eBook standard, Gemstar eBook
Publisher ensures the widest acceptance for the electronic
editions of your bhooks,

The eBook publishing process

The publishing process for eBook Editions begins with vour
content in the form of text and images. These may come from a
book already published in print or electronic form, or they may
be created specifically for the Gemstar eBoolk devices,

Fanvert ing gour conferf

The first step is to convert your content to Open eBook
document files (ODF), which are plain text files that include
HTML and OEB markup codes, As a preliminary step, you can
convert your content to standard HTML files and then refine the
HTML coding to meet the Open eBook specification (which
supports most of HTML 3.2 and Cascading Style Sheets Level 1
but does not support Dynamic HTML), If the original text is in a

format such as Adobe® FrameMaker®, or QuarkXPress®, you
can often sawve it into HTML format, either directly from the
application or through a third-party conwverter,

You also need to convert any graphics to s suitable format, The
Open eBoolk standard specifies PNG and JPG files for images,
The Windows version of Gemstar eBook Publisher also
supports WMF, GIF, and BMP files, Animated GIFs and

lossless or progressive JPEGs are not supported.

(=) i
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Gemstar eBoolk Publisher can build eBook Editions for four
different targets:
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Target Compatible devices |Display characteristics
Color VGA Gemstar eBook 480 x 640 pixel color
GEBZ2150 soreen (grayscale
Cemstar eBook socreen in SoftBook
REB1200 Readers)
SoftBook Reader™
280e
SoftBook Reader
200
Grayscale Gemstar eBook 320 x 480 pixel
Half-ViGA GEB1150 grayscale screen
Monochrome | Gemstar eBook 320 x 480 pixel
Half-ViGA REE1100 monochrome
Rocket eBook Pre™ |(1-kit) screen
Rochket eBook™
OEBFF: All | OQEBFF Container inot applicable)
Targets

| 9

The target you select determines:

+ Which dewvice (Color VGA, Grayscale Half-VGA, or
Monochrome Half-VGA) will be emulated when yvou preview

Hote When you select DEBFF: All Targets, you are not
building an eBook Bdition for a specific reading
device, Instead, you are building an OEBFF
Container, which gathers all
single, DEB-compliant file. See the following section,
"About DEBFF Containers,” for more information,

files in the project into @
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yvour edition. The QEBFF: All Targets selection does not allow
previews,

+ Which type of edition (Color VGA, Grayscale Half-VGA,
Monochrome Half-ViGA, or OEBFF: All Targets) will be created
when yvou build an edition for distribution,

« Which files will be displayed in the Spine [tems tab and
Images tab of the Project window, If vou have assigned target-
specific fallbacks (alternate files) for OEB documents or
images, the fallbacks will be listed only when the
corresponding target is selected.

Although the targets share many characteristics, each target
also has its own unigue features. Rather than forecing you to
design only for the lowest common denominator, Gemstar
eBook Publisher ensbles you to add target-specific files to your
project through its fallback mechanism (as explained in the
section "Using Gemstar eBook Publisher”), In that way, you can
optitize your eBook Editions for each target and still keep all
vour content together in a single project,

About OEBFF Containers

As mentioned in the previous section, when you select QEBFF:
All Targets as the build target, you are not building an eBook
Edition for a specific reading device. Instead, yvou are building
an Open eBook File Format (OEBFF) Container — a single,
cross-platform, MIME-encoded file that gathers together all the
information for all build targets, including a1l the publication
information (author, title, [SBN, and so forth) and all the files in
the project (project file, OEB document files, image files, style
sheet files, and all fallhacks for those files),

This QEBFF Container is not intended for delivery directly to a
specific reading device. Rather it is intended for delivery to a
back-end processing system that can then use it to create
editions specific to various reading devices, not only for
current models, but potentially for future models as well,

To serve this purpose, the QEBFF Container must include a
complete set of files that comply with the OEB specification, in
addition to any dewvice-specific files you have added to the
project, For example, the OEE specification requires that

10 |
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images bhe JPEG or PNG files, If your project includes a GIF
image that does not have an OEB-compliant fallback (JPEG or
PNG), then when yvou build an OEBFF Container, Gemstar
eBook Publisher sutomatically creates an OEB-compliant
fallback for that file to include in the OQEBFF Container,

Foraatfing gaur cffook Fdifrian

Once you've converted the content to HTML and the graphics to
the proper formats, you need to edit the HTML coding to suit
vour target devices,

We strongly recommend that you first ereate a master version
of your book for the QEBFF: All Targets selection by editing the
HTML coding so that it conforms to the Open eBook
specification. Remowe any HTML features not supported by the
Cpen eBoolk specification, and add Open eBook features such
as running headers,

Once you have a complete and correct master version for
OEBFF: All Targets, you can use eBook Publisher’'s fallback
mechanism to add alternate images or document files with
alternate coding to suit particular festures of specific devices,
For example, if you have color images in your book, you may
want to create alternate 1-hit black-and-white versions of the
images to suit the 1-bit sereen of Monochrome Half-VGA
devices,

See the Open eBook Publication Structure, included in your
Gemstar eBook Publisher folder, for information on Open
eBook coding,

Fhocking goeur code gad forecffing

Next vou'll check the coding to make sure it's correct and then
preview your formatting to see how it will look on the screen of
a particular target dewvice (Color VGA, for example). For these
tasks, you'll use Gemstar eBook Publisher, as explained in
"Using Gemstar eBook Publisher” later in this guide,

L]
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Creating effoak EFdifionz

Finally, once you're satisfied with the sppearance of your book,
voul'll use Gemstar eBook Publisher to "build” finsl versions to
submit for distribution,

You can build an eBook Edition for the Color VGA, Grayscale
Half-VGA, or Monochrome Half-VGA target, compiling the OEB
document files and images into a file ready to deliver to the
chosen reading device, Alternatively, you can select QEBFF: All
Targets to build an QEBFF Container. (See "Ahout OEBFF
Containers” earlier in this guide for more information sbout
thiz option.)

L]
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Getting Started

Requirements
To use Gemstar eBook Publisher, you need the following:

For Microsoft Windows® 98/95;

+ Pentium® processor, minimum 166 MHz
+« CD-ROM drive

« Minimum 24 megabytes of RAM (more required for large
projects)

« Minimum 10 megabytes of free hard disk space (more
required for large projects)

« Microsoft Word 95 or Word 2000 ({to import Word
documents directly)

For Microsoft Windows XP/2000/NT™ 4.0:
+ Pentium processor, minimum 266 MH=z
« CD-ROM drive

+ Minimum 32 megabytes of RAM (more required for large
projects)

+ Minimum 10 megabytes of free hard disk space (more
required for large projects)

+ Microsoft Word 97 or Word 2000 (to import Word
documents directly)

Installing Gemstar eBook Publisher
To install Gemstar eBook Publisher, follow these steps:

1 Place the Gemstar eBook Publisher CD in the CD-ROM
drive of your computer, If you're using Windews NT, you
must be logged in on an account that has administrative
access so that the proper registry entries can be modified,

)
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2 The installation program will launch automatically, (You
can also run the setup program manually from the Start
menu by choosing Run and typing DASETUP .EXE, assuming
vour CD drive is D)

3 Follow the instructions in the installation program to viesws
and acknowledge license information, specify the location for
the installed program, handle all necessary registration and
configuration of the software, and view the readme. txt file,

Uninstalling Gemstar eBook Publisher

If you decide to uninstall Gemstar eBook Publisher, use the
Add/Remowve Programs utility in the Windows Control Panel,
The uninstall process removes all files and directories added
during installation and removes any added registry entries,

Multiple eBook Publisher Versions

If you have a previous version of Gemstar eBoolk Publisher or
SoftBook Professional Publisher installed on your system then

there are some things to keep in mind when installing version
2.1,

Chur recommendation is that you not rely on being sble to run
multiple versions of Professional Publisher on the same
system. In general, yvou do not have to uninstall a prior version
before installing version 2.1 but doing so will avoid sll possible
problems,

If your prior version is Gemstar eBoolk Publisher ¥2.0 then +2.1
will completely replace and up grade this installation. [t is not
possible to have these two versions independently on the same
system. They do not appear as separate, uninstall items in the
Windows Contrel Panel - Add Eemowve Programs list,

If your prior version is SoftBook Professional Publisher v1.5
then it is, with one exception, possible to keep both versions
on the same system. The two versions use different installation
directories, commoeon files directories, and almost completely
different registry entries, The exception is the ActiveX control
used for building and previewing operations, Although a

14 I
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different version of the ActiveX control will be installed, it
registers the same COM interfaces and supercedes the other
version of the control. Therefore, once you install ¥2.1 the v1.5
installation of Professional Publisher will net be fully functional
unless the older version of the control (SBPubX.dll) is re-
registered with the system. Likewise, uninstalling either
version of the software will cause the ActiveX control to
become unregistered, even though the other version is still
present, If you have version 1.5 installed it is highly
recommended that you uninstall it first, before installing
version 2.1.

Any other prior version of Professionsal Publisher will coexist
with eBook Publisher 2.1 with no conflict,

Setting preferences

Gemstar eBook Publisher allows you to set a number of
preferences that affect its behawvior, You don't need to change
any of these before you start using Gemstar eBoolk Publisher,
and you can return to set or change preferences at any time,

To set Gemstar eBook Publisher preferences:

1 Double-click the Gemstar eBook Publisher icon to start
the program. The main Gemstar eBook Publisher window
sppears, with no project open,

L]
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%w Gemstar eBook Publisher

Fie Edi Project View 'Window Help

DBHS DD =8 alRo

Ready L [NUM | &
2 From the File menu, choose Preferences, The Preferences

dialog appears.

This dialog has two tabs: the Project Settings tab, which
contains global preferences for Gemstar eBook Publisher,
and the Edition Defaults tab, which contains preferences
used when creating a new project,

3 Click on a tab to display the Project Settings tab or the
Edition Defaults tak. The preferences on these tabs are
described in the next two sections,

4 When yvou have set these preferences a5 you wish, click
OK to save your changes and close the Preferences dialog, or
click Apply to save your changes without closing the dialog,
To close the dislog without saving your changes, click
Cancel,

L]
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Fhe Froject Seffipgs fah

In the Project Settings tab of the Preferences dialog, you can
set sound, source editing, and emulation options for Gemstar
eBoolk Publisher. These options are explained in the following
paragraphs,

Preferences x|
Progect Settings I Editiari Defzuls |

+ Sound
[ Play Sound After Bulding E diton

==
Y £

- Sounce Editng
i |rlesnal E diar
(" Use This Edbor. |

L=

— Pieviaws Oplion
[ Identity Device-Sealed Imagss

Buald Taiget Dieisull

{* DEBFF- All T argels ' Grayscale HafyGA
" Coln WGEA " Monachiome Halk- Vs,
OF. Cancel 4 op

Play Sound After Building Edition: Select this option to have
Gemstar eBook Publisher play a sound when it has finished
building an eBook Edition., You can specify a sound file to use
after a successful build and one to use after a failed build, Click
the Browse button to the right of each text box to browse for
the sound files, (This option can only be selected if your system
is capable of playing sound files,)

Source Editing: In the Source Editing section, you can specify
whether vou want to edit your OEB document files using
Gemstar eBook Publisher's internal editor or an external editor

| M7 i
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of your choice, If you specify an external editor, be sure to
select one that will not alter the Open eBook coding in your
files and will save files in plain text format. If you have any
doubts, we recommend that you select Gemestar eBook
Fublisher's internal editor instead.,

+« Intemmal Editor: Select this option to use the internal
Gemstar eBook Publisher editor, which provides standard
Windows mouse and keyboard commands for text editing
plus advanced features such as syntax coloring, suto-
indenting, enhanced find/replace, navigation commands, and
drag-and-drop editing,

+ Use This Editor: Select this option to use an external editor
of your choice. Enter the full path to the application, or click
the Browse button to locate the application, You can select
any editor that works directly with text, HTML, or Open
eBook files as a native format, Do not select a program such
a5 Microsoft Word that uses its own format unless you make
sure to convert files to and from HTML or plain text, If you are
not sure whether vour editor is suitable, we recommend you
use Gemstar eBook Publisher’s internal editor,

Identify Device Scaled Images: Selecting this option will
visually mark images in the ColorVGA and Grayscale HaliVGA
previews that are too large for the dewvice, An image can be
considered too large if its total file size (in bytes) divided by the
number of pixels (width x height) is greater than a certain
threshold walue. An image can also be considered too large if
itz dimensions are larger than the device is capsable of
displaying. In the former case, the image will be overlayed with
a green rounded rectangle. In the latter case, the image will be
overlayed with a red oval. Note that it is possible for an image
to hawe both overlays, Note, also, that for a grayscale preview
the overlays will not be in color, Any overlay indicates the
probahbility that this image will suffer from slow display on the
device and should be edited {using the image editor of your
choice) to reduce its size andfor dimensions,

Build Target Default: In the Build Target Default section,
specify the default target to be selected in the Build Target
menu of the Project window when you open a new or existing

L]
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project. This setting also determines the type of preview
displayed for a single file not associated with a Project,

Fhe Fdifrfon fefouffas fah

In the Edition Defaults tab, vou can set build, font, and cutput
folder options for Gemstar eBook Publisher, These options are
explained in the following paragraphs. (Note that these options
are used as the default settings for new projects only — if you
change them, the changes will not affect existing projects. You
can change the settings for individual projects through the
Edition Settings command on the Project menu when you have
the project open.)

Peoject Selfings  Ecifion Dfeults |

Mewst Prioject Buld Oplions
Fanl Dplians
[¥ Compress % Vigw with Lage and Smal Fore
[¥ Encrypt O Wiew wath La:ge Fant Onky

[ Undedire Links ™ Wiew with Smal For Only

[ Use Qutput Folder _|

ok | ceen | ey |

Compress: Select this option to compress the final eBook
Edition. The compressed version is smaller but takes slightly
longer to open on a Gemstar eBook, Be sure to select this
option when building eBook Editions to be sold through the
Gemstar eBookstore, (If you are building an OEBFF Container,

1 149 i
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the Compress option is applied not to the OEBFF Container
itzelf but to any eBook Editions created from it.)

Encrypt: Select this option to encrypt the final eBook Edition
so that the contents can only be viewed on the Gemstar eBook
device of an suthorized user. Be sure to select this option when
building eBook Editions to he sold through the Gemstar
eBookstore. (If you are building an QEBFF Container, the
Enciypt option is applied not to the QEBFF Container itselfbut
to any eBook Editions created from it,)

Undedine Links: Select this option to have links within the
eBook Edition underlined (a=s in most webh browsers, for
example),

Font Options: [n the Font Options section, click a radio button
to specify whether the document will be viewsble with both
large and small fonts, large fonts only, or small fonts only, If
vou choose View with Large and Small Font, then readers can
zoom from one size to the other, [f you choose View with Large
Font Only or View with Small Font Only, readers will not be
able to zoom,

Use Output Folder: Select this option to specify a default folder
for all output files (whether eBook Edition or OEBFF Container
files), Click the Use Output Folder checkhox to select it, and
then enter the full path or click the button to the right of the
text box to select the cutput folder,

If vou do not select this option, you can specify the output
folder for an individual project in the Edition Settings window
for that project. If you leave both this option and the Edition
Settings Output Felder option hlank, then yvou can specify the
output folder each time you build an eBoolk Edition or OEBFF
Container,

L]
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Using Gemstar eBook Publisher

Once you've converted yvour content into OEB-coded document
files and images, you're ready to start assembling an eBook
Edition using Gemstar eBook Publisher, Typically, you'll follow
these steps!

» Prepare your work space by gathering all the QEB document
files and image files necessary for your project.

« Create o new project file, and add the OEB documents for
the master version of your edition (fypically for the OEBFF:
All Targets selection),

+ Ifyou want to use alternate document files or images for
specific targets (Color VGA, Grayscale Half-VGA, or
Monochrome Half-VGA), add them to your project using
eBoolk Publisher’s fallback mechanism. You can then manage
all your content files through just one project file and build
eBoolk Editions for any target yvou wish,

+ Check the coding of each file, and make any necessary
corrections,

+ Preview the files and images to see how they'll look as eBook
Editions for different targets, Make changes as required until
everything is formatted correctly for all desired targets,

* Build final editions from yvour project, converting the OEB
documents and images into an QEBFF Container for all
targets or eBook Editions for specific targets (Color VGA,
Grayscale Half-VGA, or Monochrome Half-VGA).

The following sections take you through these steps in
sequence, When vou're working on a real project, you probably
won't follow this sequence straight through from beginning to
end. You're more likely to repeat the check and preview cycles
a number of times, for example, and possibly even go back to
add or remowve files before you build your final eBook Editions,
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Freparing your work space

Before you begin working with Gemstar eBook Publisher, you
need to gather your files — the image files and Open eBook-
coded document files that make up your content,

To organize all these files, we recommend that you have:

+ A folder to hold your original source documents (including
original images), if any. I[f you are converting s book, for
example, these may be Microsoft Word or QuarkXPress files
uzed for the print version,

« A folder to hold all your OEB document files, These will be
irlain text files with HTML and OEB coding,

« A folder to hold all your image files, These image files must
be in JPEG, PNG, GIF, WMF, or BMP format,

+ A Project folder to hold the project file (which you'll create
in Gemstar eBook Publisher), the OEB document file folder,
and the image file folder.

+ A Distribution folder to hold the files cresated when vou build

yvout final eBook Edition,

=] quide
] dishibution ——— OEBFF or eBook Edition files
=[] project Project file
=] b fles OEE document files

[# ) imagez— Image files
| smace

Original source documents

Creating a project file

The first step in building an eBook Edition from yvour OEB
document files is to set up a Gemstar eBook Publisher project
by creating a new project file, In the project file, you:

+ Store information about the eBook Edition, including its
Edition ID, title, authot, ISBN, publisher, copyright date, and
so forth,

+ Identify the OEB document files that belong in the project.

L]
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+ Specify the order in which the files should appear.

In addition, you'll use Gemstar eBook Publisher's Project
window as a starting point for checking and previewing your
QEB document files,

To create & new project file:

1 From Gemstar eBoolk Publisher's File menu, choose Newr
Project to open a new, untitled Project window,

% Gemstar sBook Publisher - [Unlitled]

B Fls Ed Plomet Visw Windew Help =18 x|
eSS + VD el a s &
Build Taiget; | CEESF: o0 Tagat: =]
E ditizn Tile:
E ditizn Authior:
gmnms] Inage: 5%
[k Diescaption Taeget File Mame e T aagent DEE Siehr

| - | |

He=ady HLUM

2 Choose Edition Settings from the Project menu. The
Edition Settings dialog sppears (shown in the following
section).

3 Enter the project information in this dialog, including the
Edition [[, author, title, and category of the eBook Edition
voul'll be creating, See the following section, "Entering the
project information,” for instructions,

3
H

L]
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4 Save your new project, (Even though you have not started
to add any files yet, it's a good idea to save the project file,)
Choose Save from the File menu or click the Save File icon,

2 In the Save dialog box, navigate to the project folder you
created previously and enter s name for the project file,
Gemstar eBook Publisher automatically appends the
extension .opf (for OEB Project File),

Hote |To open an existing project file, choose Open from
the File menu or click the Open File icon.

Entering the project information

The project file contains information sbout the eBook Edition
vou'll be creating, including the Unigue Book ID, title, author,
ISBN. publisher, and copyright date. You don't need to enter
this information to begin a project, but you do need to enter it
before you can create an eBoolk Edition,

To enter or change the project information:

1 |2[if the Edition Settings dislos is not already open,
choose Edition Settings from the Project menu, or click the
button on the toolbar at the top of the Project window. The

Edition Settings dialog sppears.
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Edition Settings e x|

Edtian 110 | Descrption | Identilisrs | Bookstere | Pricing | Buid Optiars |

Unicyae Edition 102 [ebook:guid- 20809062206044740302355c.  Wew D1 |
[ Fequre ISBM: |0-7598-1538-5

Ttz [requred] I.-fl.rr:ncl Houze
Fie &3 larngel House

Authee [iequiredt  [Man Grattaneli

Fie Az |Grottaneli, Man
Publisher: |12t Books Library
|Priprirk: I
Larguags |em Eraleh = Copwicht Date: | A001-07-01
Jor Eng = [ T MM-OD) |
Publish Date:  [2001-07-01
[ -MMOD)
0F Cancel
2 The Edition Settings window is organized into six tabs

(Bdition Info, Description, Identifiers, Bookstore, Pricing,
Build Cptions), Click on a tab to bring it to the front, and
then enter the information according to the guidelines in the
following sections.

3 When yvou've completed all the necessary information,
click OK to close the Edition Settings window and save the

information. Note that certain fields are required to build an
eBook Edition or OEBFF Container,
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The Edition Info tab contains the Unigue Edition ID, ISEN,
language, title, author, publisher, imprint, copyright date, and

Lnigue E dition 10): [&‘uﬂ:uﬁd-?bﬂﬂﬂaﬁ&ﬁﬂqi?ﬂaibﬂﬁﬁc Mew I

= Feque 1SEN: ||:|?55|'3'153|]5

Title |recuied]} |.l:l.n[|-=I Honese

File As: langel House

Authoe [requined): | Fan Giotlaral

File As: |Girattaneli, Man
Publigher: |'| st Backs Lbram
Imiprit: |

Lenguage: [en: Erglsh =

1 126

Capwrioht Date: [2001-07-01
[ rr-M-DD)
Fublich Date:  |2001-07-01
BTy -HM-D0)

Unique Edition ID: This identifier iz used to uniquely identify
the eBook edition in both BookStore servers as well as on any
given reading dewvice, Because these identifiers must be unique
Gemstar eBook Publisher will sutomatically generate the ID for
vou rather than ask that you enter one. Howewer, the generated
ID is displayed for you in & read-only text box. You can
highlight the entire ID (it will scroll horizontally as needed) and
use Ctri+C to copy the text to the system clipboard.

New ID: Press this button to generate a newr unique identifier,
You will want to do this if you have copied a project file from
another edition to begin a new one. You may also want to do
this if you hawve changed the [SEN number for this edition and
wigh it to represent a new edition in an electronic bookstore,

L]
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ISBN Required: Checked by default, this option indicates
whether an [SBN number must be entered for this project, If
vou have a project that does not require an [SBEN number or for
which an [SBN number does not make sense then clear this
option,

ISBN: Enter the [SBN number for your edition, You must enter
all 10 digits of the [SBN number, but you may omit the
hyphenation, When validating input, the checlk digit of the
entered [SBN will be verified, If you change the [SBN number
and have not generated a new unigque identifier then you will be
asked if you wish to do so,

The ISBN field will be disabled if the sbhove, ISBN Required,
field has been cleared. However, if the required option is
checked then you must enter an [SBN number,

Title (required): In the Title box, enter the title of the book you
are converting as it appears on the cover or title page (for
example, The Canterbury Tales) This item is required,

In the accompanying File As box, enter the title to he used for
sorting (for example, Canterbury Tales, The).

Author (required): In the Author box, enter the name of the
author of the book you are converting as it appears on the
cover or title page (for example, Geoffrey Chawcer), If the book
has multiple authors, enter the full name of each, separated by
comimas (for example, "Jane Doe, John Smith, Mary Jones"), If
it is an issue of a periodical, enter the issue date here, This
itern is required,

In the accompanying File As box, enter the author's name as it
should be used for sorting (for example, Chaucer, Geoffrey).
Note, though, that there is no required format for this field,
that it is not required, and that what to enter here is totally up
to vou (especially in the case of multiple authors or 2 periodical
issue],

Publisher: Enter the publisher of the book,

Imprint: Enter the publisher’'s imprint for the book (if there is
onel.

L]
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Language: Select the language in which the book is written
from the Language menu,

Copyright Date: Enter the copyright date of the book in the
form YYYY-MM-DD (for example, 2000-12-31 for December 31,
20007,

Publish Date: Enter the date the eBook Edition is to be made
available in the bookstore, in the form YYYY-MM-DD (for
example, 2001-12-31 for December 31, 2001},

Heacripf fon

The Description tab contains three desecriptions of the book
(short, medium, and long), These descriptions are kept with the
book and used for the Bookstore and Catalog to display
information sbout the book,

Editian Infa  Pesztiptien | Identfiers | Bockstore | Pricing | Build Options |

Brief Descaiption [255 charg):

L Ll

Limited Description [1000 chars}

B |m

Fuil Desenation:

L]

hd |

Brief Description: Enter a brief description of the book, no
longer than 255 characters (approximately 50 words or less),

L]
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This description is displayed in the multiple book view of the
online bookstore or web bookstore,

Limited Description: Enter a slightly longer deseription of the
book, limited to no more than 1000 charscters (approximately
200 words or less), This description is displayed in the
REE1200 and REB1100 catalogs.

Full Description: Enter a full description of the book, of any
length, This description is displayed when viewing the full
information for a book on the online or web bookstores,

fdenfrfrers

The ldentifiers tab contains more information for identifying
the eBook Edition, including identifiers for Periodicals,

Fiefening ISEH: |

™ Penodical

Cortent Feed D0 |
Jegqured]
Ismus Mumie |
jiequined]

Referring ISBN: If the eBook Edition is an electronic version of
a print book, enter the ISBN of the print version here.

L]
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Periodical: [f this eBook Edition is an issue of a periodical — a
daily neswspaper or monthly magazine, for example — check the
Periodical bhox, and then fill in the Content Feed ID (which
identifies the periodical to which this issue belongs) and the
Issue Number (which distinguishes one issue from another):

« Content Feed ID irequired): Enter the [SBN of the periodical
of which this document is an issue. The [SBN entered here
must match the [SBN entered on the Edition Info tab but
should not include any hyphens (for example, 122233333X
rather than 1-222-33333-X). This field is required for a
periodical,

+  Issue Number (required): Enter the issue number of this
eBook Edition of the periodical, Start the numbering with 1
for the first eBoolk Edition issue. (Do not use the issue
number of any print version of the periodical.) This field is
required for a periodical,

It is important to identify periodicals and issues properly
because the Gemstar eBook distribution tools allow each new
issue of a periodical to replace previous issues automatically.

Popkzfares

The Bookstore tab contains information on the category, BISAC
(Book Industry Systems Advisory Committee) codes, keywords,
and cover art for the eBook Edition,

L]
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Editian Infa | Desciipsion | Identiiers  Bockstoe | Fricing | Buid Options |

Boow shel Categony: |Ee*ua|al Interest :l

[regqurad)
BISal Codas: Seaich Kepsonds:
= =]
H |
Corver At

Morochiome: I J
Girayzcals | J
Color: | =]

Bookshelf Category (required): From the Bookshelf Category
meniy, select the name of the category under which the eBook
Edition should be listed on the bookshelf of the user’'s reading
device, This item is reguired,

The default categories are:

+ News and Periodicals: Msgazines, newspapers, newsletters,
and all other periodicals,

+ Fiction: Fiction of all types, including popular, literary, and
genre fiction,

+ General Interest: Most fiction and non-fiction works that are
intended for general readership or that don’t fall inte one of
the other categories,

+ Professional Reference: All professional references such as
medical or other profession-specific dictionaries,
programimet's references, and similar works,

+ Reports: Reports of all kinds, including corporate,
academic, and professional publications,

1 31 i 96
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If you do not find the category you want listed on the menu,
voul can click in the Category text box and type in the proper
category name.

BISAC Codes: Enter the BISAC (Book Industry Systems
Advisory Committee) codes that define the subjects under
which this book should be listed (for example, FICO00000 for
FICTION). If you enter more than one code, enter each code on
a sepatrate line. For a list of the 48 top-level BISAC codes, see

"Appendix A: BISAC codes” at the end of this guide,

Search Keywords: Enter heywords or phrases to be used in
bookstore searches, Enter each keyword or phrase on a
separate line,

Cover Art: Select JPEG or PNG images to be used as cover art
for the eBook Edition in the bookstore, Click the Choose
buttons (or type in the full paths) to select images for the
Monochrome cover (1-bit monochrome, 75 pixels wide, 88
pixels high), Grayscale cover (grayscale or color, 75 pixels
wide, 88 pixels high), and Color cover (color, any size), If the
Grayscale cover image is color, it will be converted to
grayscale. The Color cover image will be resized as needed for
display in bookstores or on reading devices (to sizes as small
as 7D pixels wide by B8 pixels high), so choose an image that
will resize effectively.

Fricing
The Pricing tab contains information on the retail price of the
eBook Edition in various currencies and trade zones,

L]
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Editian Infa | Descipsion | |dentiiers | Bockstare  Fricing | Build Dptions |
[ Piice Brding

Trada £ore: Cunency: Aetal Puics

=l = fd

Price Binding: [n some countries, contracts with publishers
tmay dictate that certain titles may not be discounted at retail.
Select this option to indicate that price binding is in effect for
this title,

Trade Zone: Enter the trade zones in which the book will be
sold, using the IS0 3166 standard three-character country
codes (USA, for example). See "Appendix B Country and
currency codes” for information on country codes, Enter each
trade zone (if more than one) on & separate line in this list,

Currency: Enter the currency to be used for pricing in each
trade zone, Use the IS0 4217 standard three-character
curtrency codes (USD for US dellars, for example). See
“Appendix B: Country and currency codes” for information on
currency codes. Enter each currency (for each trade zone) on a
separate line in this list,

Retail Price: Enter the suggested retail price for each trade
zone and currency, Enter each price (for each trade zone and
currency code) on a separate line in this list,

1 {323 |
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Note that you must enter the same number of trade zones,
currency codes, and retail prices in the three fields,

Furld fpffons

The Build Options tab contains options to be used when
building an eBook Edition, including encryption and
compression,

Hote For books to be submitted to the Gemstar
eBookstore, select the Compress, Encrypt, and
Underline Links options, and set Font Options to
View with Large and Small Font

Edition Infa | Descripion | Identifiers | Bookstors | Pricing  Buld Opticrrs

Fant Size:

0¥ Wiew wath Lage and Small Font ¥ Compress

™ Wigw with Small Fant Dok M Encipt
Wi welh Laigs Fork Oy B Uredathne Links

™ Use Glossay Fis

| =

™ Usze Owput Folder

| N

Font Size: In the Font Size section, click a radio button to
specify whether the document will be viewsble with both large
and small fonts, large fonts only, or small fonts only. If you
choose View with Large and Small Font, then readets can zoom
from one size to the other, If you choose View with Large Font

1 (T I
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Only or View with 8mall Font Only, readers will not he able to
ZOOMm,

Com press: Select this option to compress the final eBook
Edition, The compressed version is smaller but takes slightly
longer to open on & reading device, (If you are building an
OEBFF Container, the Compress option is not applied to the
OEBFF Container itself but to any eBook Editions created from
it}

Encrypt: Select this option to encrypt the finsl eBook Edition
5o that the contents can only be viewed on the reading device of
an authorized user, Be sure to select this option when building
eBoolk Editions to be sold through the Gemstar eBookstore, (If
vou are building an OEBFF Container, the Encrypt option is not
applied to the OEBFF Container itself but to any eBook
Editions ereated from it.)

Undedine Links: Select this option to have links within the
eBook Edition underlined (a=s in most webh browsers),

Use Glossary File: [f you want to add a glossary file to be used
when building an eBook Edition for Color VGA or Grayscale
Half-VGA targets, select this option, and then click Choose to
select the glossary file, The glossary file will be ignored when
building an eBook Edition for the Monochrome Half-VGA target.
For more information, see "Adding a glossary file” later in this
guide,

Use Output Folder: To specify the folder in which to store the
final eBoolk Edition files for this project, enter the full path or
click the button to the right of the text box to select the folder,
If you specify an output folder here, then when yvou click the
Build Edition button or choose Build Edition from the Project
menu, Gemstar eBook Publisher begins building the eBook
Edition immediately, using the settings in the Edition Settings
windowr,

If you leave this option blank, then s Save dialog appears each
timme yvou build an eBook Edition or OEBFF Container so that
vou can specify the output folder at that time,

L]
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Adding files to the project

Once you've created a new project, you need to add the OEB
document files that will he used to create the eBoolk Edition,
These files should be plain text files with OEB (or HTML)
coding,

Hote I this guide, we use the file suffix .odf (DER
Document Formeat) for the OEB document files to
distinguish them from standard HTML files, However,
you can also use any of the following file suffixes:
bl Jhim, ixt oxoml osgm, osoml, asp, shm, or
Ehml,

To add files to the Project window, either drag and drop them

from Windows Explorer®, or use the Add Files command from
Gemstar eBook Publisher's Project menu., You can add files
singly, in groups. and in nested folders, All files added to a
project are listed in a simple flat structure in the Project
window, even if they are stored in nested folders on your disk,

If you add a group of files to the Project window, they may not
appear in exactly the order you want, but you can reasrrange
them easily. See "REearranging the order of spine items" later in
this guide,

For the Color VGA and Grayscale Half-VGA targets, you can
also add a glossary file to the project. This file works with the
Select tool on the Pen Palette of Color VGA and Grayscale Half-
VGA dewvices to provide definitions for selected words, There
can be only one glossary file in a project, and it must have the
file suffix .gls or .glos. See "Adding a glossary file” later in this
guide more information,

Hote When you add files to a project, you're ereating o
link to those files, not moving or copying the files,
When you remove files from a project, you're orly
remouving the link, not deleting the actueal files,

L]
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Adding Fifes using drog ond drap
To add files to a project using the drag and drop method:

In Gemstar eBook Publisher, make sure the Project
window is open,

In Windows Explorer, select the files you want to add to
the project, drag them into the Project window, and drop
them there, You can add files in nested folders if you wish,

¥ Iy O & 0D el a s
Cid Copy  Pale
=] Buald Target: [JEBFF: &0 Tt =l
Edition Title:

Hame Ecktion Author:
] i
] hemgih
S councha 00 el "
"'iu;ll:L-[l'.l_l'I I. 51:!"!".!11-&' Immgey ] CES ]
. 7 ol L
4::::"1 | e Decrpian Tage FleHans | Sa Tew
5 cuicke (4. o iy T
5] cuedel15 o - i
S cindktS nad

Hdding Fifea uaing (he Rod Files cossand
To add files to a project using the Add Files command:

In Gemstar eBook Fublisher, make sure the Project
window is open,

Choose Add Files from the Project menu, or click the Add
Files button on the toolbar at the top of the Project windowr,
The Add Files to Project dialog appears,

L]
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Add liles o progect
L,;ul-_i_n; |J e j ﬂ ﬂ Eﬂ
|| mages = gquid=[5.0dl i 2 5 ’

'*'_-l guidell odl

B guade(.odl

=) gquid=06.odl
= guid=0i.adl
=) gquid=08.adl
=) gquid=09.0dl
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Files of bype: |LI|:I:r| gEook Dosurmenl Fikes " o] j Cancel |

[T Dpen as pead-cnly

oA

3 In the dialog, navigate to the folder that contains the QEB
document files for the project,

4 Select any or all files that you want to add, and click Open,
The files appear in the Project window,

Fapart ing Mord ar FIF docussnts

In addition to adding already-coded OEB document files as
described in the preceding sections, you can also import
Microzoft Word or ETF (Rich Text Format) documents, When
voul import & Word or RTF document, Gemstar eBook Publisher
converts the document into an OEB document file that
attempts to preserve the formatting of the original, Gemstar
eBoolk Publisher can add the converted file to an existing
project, create a new project for it, or save it without adding it
to =2 project,

Hote To import a Word document, Gemstar eBook
Publisher launches Word and runs ¢ series of Word
macros to convert the document to an OEB
document file,
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To Import & Word or RTF document:

If you want to add the converted Word or RTF document
to an existing project, open the project in Gemstar eBook
Publisher. If you want to create a new project for the
converted document, close any open projects before you
proceed,

Choose Impeort from Gemstar eBook Publisher's File
menu, The Import MS Office Document dialog appears.

Laok jn: [ 3 source = & 2 el [ =

Filepame:  [Adderdum doc | Open I
Filect of bypeer. | Impart Fies [* doc:® ] =] Cancel |

Select the Word or RTF document that you want to
convert, and click Open, The Save dialog appears,

The options in the Save dialog vary. depending on whether
vou currently have s project open or not:

If you have a project open, the Save dialog includes an Add
Converted Document to Active Project option. If you select
thiz option, Gemstar eBook Publisher adds the converted
document to the open project,

L]
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If you do not have a project open, the Save dialog includes an
Add Converted Document to New Project option. If you select

this option, Gemstar eBook Pub
file in the same directory as the

lisher creates a new project
converted document, adds

the converted document to the project, and opens the project

in the Project windowr,

Save converled document as

Sawe n |_i pioject

= B & & = &)

File mame: |.:||:|:|n-|d1.m ol

Sewe s lype: | Open eBock Document Fil [ adl]

[+ fid canwerted dacumenl ba rew prajgct
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4 Locate the folder in which you want to save the converted
document, and click Save, Gemstar eBoolk Publisher displays
a progress window as it converts the document, If it
encounters errors in the conversion, it lists them in the
window, If not, it saves the converted document to disk as an
OEB document file and adds it to the Spine [tems tab of a
new ot existing project if you selected one of those options,

Hdding o gfossary file

When vou build an eBoolk Edition for the Color VGA or
Grayscale Half-VGA target, you can add a file containing a
glossary of terms to your project, [f you add a glossary file,
then readers viewing the eBoolk Edition on a Color VGA or
Grayscale Hali-VGA dewice can tap a glossary term in the text to
display a search menu, and then tap the Define button to
display the glossary entry for the selected term,

To make a glossary file for these targets, create a text file with
an extension of .glos or .gls (for example., guide. glos). In this
text file, enter the glossary terms and their definitions, using
the following format for each glossary entry:

« One or more terms for this glossary item (separated by
commas if there's more than one term),

A tab (to separate the term from the definition).

The definition of the glossary term (or terms).
« Areturn (to mark the end of the glossary item),

For example, you might enter the following (where ¢t
represents a tab character and (fcm@w a return character):

RGE ¢ 7288 system for describing colors as mixtures

of red, gresn, and blue. GRETLEN.

FO5, point of sale¢fHB8.The location in a store gt
which goods are purchased. (RETLRNY.E

Hote Glossary terms are not case sensitive,

41 I
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To add a glossary file to your project:

1 Chpen the Edition Settings window for the project by
clicking the Edition Settings button on the toolbar at the top
of the Project window or choosing Edition Settings from the
Project menu. The Edition Settings window appears,

2 In the Edition Settings window, click the Build Options tab
to bring it to the front,

Editian Infa | Desciption | Identfiers | Bockstore | Pricing  Buld Optieess |

Font Size

0% Vigw with Large and Small Font + Compress

" Viow with Small Font Dinky i Enciypt
Wi welh Laigs Fork Oy B¢ Uredathne Links

[ Uze Gloszaiy Fis

| =

[T Use Oput Folder

| -

3 Click the Use Glossary File checkbox to select it, and then
click the button to the right of the text box. The Select
Glossary File dialog appears,

L]
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Look jn: | ' oeb files j ﬂ m EE

|_|E'I Thages

Fite pame.  [guide. glos | Dpe=en I

Filess of Bepasc |I':h5:z.'||_l.l Files [ gk, * ghas) j Cancel
s

4 Select the glossary file, and click Open, The glossary file is
added to the project and its full path appears in the Build
Options tab, (It does not appear in the Spine Items list),

¥ Use Glossaip Fils

||:.".uud|=".:.lluwul".-:||=bIlhs".-uude.;klr J

A guide to the Project window

As vou use Gemstar eBook Publisher, you'll do much of your

worlk through the Project window, This section points out key
features of the Project window, and following sections explain
how to use the Project window to manage the content of your

book — your OEB document files, images, and external style
sheets,
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The Project window uses a tabbed interface with three tabs: the
Spine [tems tab, which lists the parts of the book and their
corresponding OEB document files; the Images tah, which lists
the images used by the OEE document files; and the C55 tab,

which lists any external style sheets used by the OEB
document files,

Going from top left to bottom right, the Project window has the
following buttons, tabs, and menus:

E New Project: Click the New Project button to
create a new project,

Open Project: Click the Open Project button
to open an existing project,

Save: Click the Save button to save the
contents af the current windowr,

% Print: Click the Print button to print the
contents of the current windowr,
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W Cut: Click the Cut bhutton to cut the selection
to the clipboard,

Copy: click the Copy button to copy the
selection to the clipboard.

Paste: Click the Paste hutton to insert the
contents of the clipboard.

Add Files: Cliclk the Add Files button to add a
new file to the project.

 Edition Settings: Click the Edition Settings

' button to open the Edition Settings window
for this project so that you can add or edit
project information,

¥ Build: Click the Build button to build an
4l =Book Edition for the currently selected
target.

Preview Edition: Click the Preview Edition
button to preview the entire eBoolk Edition for
the currently selected target (except OEEFF:
All Targets, which cannot be previewed),

o[ J: OEB Check All: Click the OEB Check All
button to check the OEB coding of all the OEB
document files listed for the current target,

|DEBFF. &8 Tt

- Build Target: Use the Build Target menu to

~ select the target (OEBFF: All Targets, Color
VGA, Grayscale Half-VGA, Monochrome Half
VGA) for building an QEBFF Container or
eBook Edition, for previews, and for OEB
error checks, (You cannot previess OEBFF: All
Targets.)

Spine Ibam | Spine [tems: Click the Spine Items tab to

|
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display the list of spine items for the project.
This list includes the OEB document files for
the currently selected target.

Images | Images: Click the Images tab to display the
list of images for the currently selected target,

£55 | CS85: Click the CSE5 tab to display any external
style sheets used by the OEB document files,

Preview... | Preview: Click the Preview button to preview
the items selected in the Spine Items tab, If
voul select more than one item, each appears
in a separate Preview window, This button is
present only in the Spine [tems tab,

vewoio.. | View Info: Click the View Info button to open
an Info window that displays information
sbout the selected items. In this window, you
can also add s fallback for the selected item, If
vou select more than one item, an Info window
asppears for each item, one at a time, This
button is present only in the Spine [tems and
Images tabs,

OEB Check | OEB Check: Click the OEB Check button to
check the OEEB coding of the selected items, If
vou select more than one item, each will be
checked in turn, This button is present only in
the Spine [tems and C8S tabs,

Delste | Delete: Click the Delete button to delete the
selected items, If you select more than one
itetn, all selected items will be deleted at onece,
This button is present only in the Spine [tems
tah.

gar. | Edit: Click the Edit button to edit the
currently selected items. If you select more

1 4e =
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than one item, each will be opened in a
separate editor window, In the Spine [tems
and C55 tabs, files are opened with the
internal editor or your chosen external editor,
depending on your settings in the Preferences
window, In the Immages tah, files are opened
with the sppropriate graphics editor,

Working with spine items

In the QEB specification, the spine items are the book parts
that you assemble for your eBook Edition. In a typical book,
these spine items might correspond to the title page, table of
contents, chapter 1, chapter 2, and =so forth,

In the Bpine [tems tab, each spine item is associated with at
least one target file — that is, an OEB document file that
provides the content for that spine item when building an
eBook Edition. In some cases, you may have more than one
target file associated with a particular spine item because
Gemstar eBook Publisher allows you to specify a fallback file
(that is, an alternate file) to be used for the spine item when
building a boolk for a particular target,

Hote I this guide, we use the file suffix .odf (DED
Document Formeat) for the OEB document files to
distinguish them from standard HTML files, However,
you can also use any of the following file suffixes:
bl Jhim, ixt oxoml osgm, osoml,  asp, shm, or
skl

For example, suppose that Chapter 2 of your book contains a
table to display information. Color VGA and Grayscale Half-VGA
devices can display OEB-coded tables, but Monochrome Half-
VGA dewvices can't, With Gemstar eBook Publisher, you can
create two versions of the OEB document file for Chapter 2,
one (chap0Z.0df, for example) for the OEBFF: All Targets, Color
ViGA, and Grayscale Half-VGA targets and s second
ichap02_moneo.odf, for example) without any tables for the
Monochrome Half-VGA target,
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In the Bpine [tems tab, you can assign chap0Z.0df as the target
file for the Chapter 2 spine item and then add the alternate file,
chap0Z_mono.odf, as a fallback for Chapter 2 for the
Monochrome Half-ViGA target, When yvou build eBook Editions,
chap0Z.odf will be used for the Color VGA and Grayscale Half-
VIGA targets, but chap02_mono . odf will be used for the
Monochrome Half-VGA. (For the OEBFF: All Targets, all files,
including fallbacks, will be added to the OEBFF Container.)

When yvou select different targets from the Build Target menu in
the Project window, the target file listed for a particular spine
item will change if you have added a fallback file for the
selected target,

Hote Al the spine items listed on the Spine [tems tab will
be used in any eBook Edition you build from the
project. You can specify e fallback file to be used for
& spine item when building for a particular target,
but you cannot specify that ¢ spine item be omitted
for a particular target,

Haing the Lpipe Ffcaz faob

When yvou first add a group of OEB document files to s project,
they sppear in the Spine [tems tab, which will look something
like the following screen, with generic entries for the item
descriptions and a question mark icon for the OEB status:

Spane Nams I Images ] S5 ]
Ibemn D ezcriplion Target File Hame Size Taigel OEE Skabus -~
o <ltem Desciigion: [ guice00 od T DEAFF: Al Targetz
=i <llem Descuphons E:L-lde[l'.nd 5k CEBFF: &1 Tagels
e <llem Descriptions puidel? oo 2K DEEFF: &1 Tangats
5 cltem Descrictions [ guidel3 o 2K DEAFF: &1 Tangets [#

The five columns provide the following information:

Item Description: The [tem Description column displays a
description for each spine item. The icon to the left of the

description is either a single sheet £ to indicate an item with
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no fallbacks or a stack of sheets B to show that the item does
hawve fallbacks,

When yvou add s file to a project, it is assigned the generic
description “<ltem Description=.” To change the generic
description to something more meaningful (Front Matter,
Introduction, Chapter 1, ete.), click on the description to edit
it, Although the item descriptions are not used in the actual
building of an eBoolk Edition, we do recommend that you add
meaningful descriptions to help organize your project.

Target File Name: The Target File Name column displays the
name of the OEB document file assigned to each spine item for
the currently selected build target. If you have assigned a
fallback for a particular spine item, then the name of the target
file will change when you select a new target from the Build
Target menu,

If you hold your mouse cursor over the file name for a few
seconds, Gemstar eBook Publisher will display the full path to
the current target file for that item,

The icons to the left of the OEB document file names indicate
the following:

The green icon with the circle indicates that the link to
the OEB document file is walid,

The red icon with the X indicates that the link to the

OEEB document file is broken, and the file cannot be
found,

Size: The Size column displays the size of the current target
file,

If vou hold your mouse cursor over the size for a few seconds,
Gemstar eBook Publisher displays the exact file size in bytes,

Target: The Target column displays the build targets for the
current target files, If you have not assigned any fallback files,
then the targets will all he QEBFF: All Targets, no matter which
build target is selected from the Build Target menu, However, if
voiul have added a fallback to be used for a particular budld

1 49

L]




=

L

Gemstar eBook Publisher 2.1 : YWindows User s Guide

target, then the entry in the Target column will change when
that build target is selected from the menuy,

If you hold your mouse cursor over the target for a few
seconds, Gemstar eBook Publisher displays the target’'s OEB
trpe (textlx-ceb l-document, for example).

OEB Status: The OEB Status column displays an icon to
indicate the QOEB check status of each target file for the
currently selected build target:

The yellow icon with the question mark indicates that
E the OEB document file has not yet been checked for
ErtOrs,

The green icon with the check indicates the OEB
document file has been checked and found to have no
WAInings or errors,

the OEB document file has been checked and found to
hawe warnings and errors, See the Errors and Messages
window for details,

E The yellow icon with the exclamation point indicates

The red icon with the slashed cirele indicates that the

%] OEB document file has been checked and found to have
fatal errors that prevent the previewing or building of
ann eBook Edition, See the Errors and Messages
window for details,

If you hold your mouse cursor over the status icon for a few
seconds, Gemstar eBook Publisher displays a text description
of the status,

Using context menus

When you select one or more spine items and click the right
mouse button, a popup context menu sppears:

S0 =1
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T angst Fite Mame
el oo

Erensien

A Windows User s Guide

Freview the selected file,

i DEE Check —— Check the selected file for errors.

o Lelate i Delete the selected file,

o Edt | Open the selected file for editing.
y Wiewd |nfio_ Dpen the ltem Information windaw

The order in which the
Edition, When you add

the order easily.

window at once, the
the top or bottom,

faor the selacted file.

From this menu, you can previesw, OEB check, delete, edit, or
wiewr item information for the selected itemis),

Aoegrraonging (he order of fhe apine Ffess

spine items sppesr in the Spine [tems

taly is the order in which they'll appear in the final eBook

files to a project, the spine items may

not sppesr in exactly the order you want, but you can change

To rearrange the order of the items by dragging:

1 In the Spine [tems tab, click and drag the icon of the spine
item vou want to move, As you drag up and down the list,
vou'll see a “ghost" icon and a solid black arrow that both
move up and down the list in syne with your mouse. The
black arrow indicates where the file will appear when you
drop it, If there are more items than can be displayed in the

list scrolls sutomatically when you reach

Spineltems | Images | CS5 |
Ibzm Deseialian Tagel Fils Mame | Sims Taiget OEB Status
| Frort Mattes & TOC [ guidel0 oo 7¥  OEBFF: Al Tangets
= inﬂzni act 5% OEAFF: Al Tangsts
[ ke idel odf 2% OEBFF: Al Tangsts
2 DEBFF; &1 Targsi: <M
&) Chapler 4 guide[d. ocl S5E OEBFF: & T arg=iz 3
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2 When the ghost image and the black arrow sppear in the
location you want, release the mouse button to drop the file,
Gemstar eBook Publisher reorders the list to show the file in
its new position,

3 Eepeat these steps as needed until you have all vour files
arranged in the proper order.

Hdding Ffollfbocks for spine ifems

Gemstar eBook Publisher’s fallback mechanism allows you to
specify alternate OEB document files to be used for different
build targets. So yvou can, if you wish, assign one OEB
document file for the Color VGA target and a different file for
the Monochrome Half-VGA target, This feature allows you to
create alternate files coded to suit the characteristics of a
specific device (the color sereen of Color VGA devices, for
example) and still keep everything organized in a single project
that can be used to build eBook Editions for any target.

To add s fallback file for a spine item:

1 In the Spine [tems tab, click on a spine item to select it,
and then click View Info. The Spine [tem Information window
for that spine item appears, listing the current OEB
document file for the item,
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2

i spmne [kem Inloamalson - Chapler 1 E

Iterm Desciiption: ||:|-a.:-:en'-

- Gipirie |len List -
Taiget | SpucefieMame | See | OEB Skstus
DERFF- &1 Targeis  [dguidel] ocf 5K
S Diel=te Ereview DEB Check Edi: |
¥ Cancel |

Click Add to add a fallback file for the spine item, The Add
Fallbacks dialog appears.

R

Add lallback.z

Laak jn: | "3 oeb files

!;I mages ggn:l:];-.".-:-d' E_EI.II:E{H_H'!:IHD.IZIIH 'ggud:15
EI gude.csz gnge]'_:l.-:-d' ‘E'] cuidelrd odl 'ggudﬂl:'-
= pude.glos gngde]ﬂ.-:-d' ﬂ cudel L od 'ggudz'l i
EI guide_calorcss |‘;-guln:h:]':-.-:-d' E|_I:l.||:e' 1.od "‘,:_"lgudzll:i
H_E"]gl..l:h:Ll.l adl gnge]ﬂ:d' E]_I:l.ll:u-'}! odl 'ggur:ls'l':l
b_Elh;l.l:h:LI'I.:u:l W= quidell 7. od! ¥ cudel 3 od W quids 20
51 puadell_rrome. od! I SSENT DUERESE % cudel4 od ¥ quide
1| | i
Filname:  [quid=01_mona.odf Cpe=n

Files of bpe |20l Fiez ||
[T Open as poadcoly
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3 In the Add Fallbacks dislog, locate the OEB document file
voul want to add as a fallback, click to select it, and then click
Add, The fallhack file sppears in the Spine [tem Information
wincdows,

i spme [tem Inloamalson - Chaglean 1 E

Item Descipton II:I--Eq:l:El 1

Eping |been izt
Taiget | SpuceFieMeme | See | OEB Stebus
DERFF- &1 Targeis  [dguidell ocf 5K B
OEBFF- &1 Target: [ quideD]_mona oo 5K [#
Add Delste Pravisw DEB Check Edt |

¥ Cancel |

Tip You can also add a fallback by dragging a file from
Windows Explorer and dropping it in the Spine [tem
Information window,

4 Click the target name in the new file's Target column. A
mmeny appears from which you can select the huild target for
this fallback file,

Taiget Souica Fle Mama  Siss | OEA Stalus
OEBFF- &1 Tagetz [ guid=D1.adi SE B
Monachrome HatvGa, [ quideDl_rmona oo 5K [Ea

Note that you must have one file for this spine item assigned
to OEBFF: All Targets, although you can change which file
that is, Also, if you assign more than one file to a particular
target, Gemstar eBook Publisher will use only the first of the
assigned files and ignore any others for that target,

|
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While the Spine [tem Information windeow for this spine item
is open, you can take further action on files listed in the
window, including previewing, running an OEB checl, editing,
or deleting files, See the following section, "Using the Spine
[tem Information window,” for more information,

3 When vou've completed your changes, click OK to close
the Spine Item Information window and ssve your changes, or
click Cancel to close the window without saving changes,

When yvou return to the Spine [tems tab, you'll see that the
icon in the [tem Description column has changed from a

single sheet E to a stack of sheets [E to show that this spine
item now has fallhack files,

Spine |h=“| Image: ] CS5 ]
Itz Drezpiiption Taiget Fila Hama | Siza Taiget
[S1Frant Matier £ TOC [ gudedl oo 7K. OEBFF: Al Tagsts
(= Chaater 1 i e ook SK  OEBFF. Al Taipsts

And when you use the Build Target menu to select the target
vou added a fallback for, you'll see that the file name listed in
the Target File Name column changes (from guide0l.odf to
guidell mono.odf in the example shown), as does the target
listed in the Target column:

Spine |h=“| Image: ] £S5 ]

Iieen Desciiption Taiget Fila Hama | Siza Taiget

[l Frant Matier £ T0C [ gudeD oo 7K OEBFF Al Taigsts
(=5 Chanten 1 [ oudedl_morciodl 5K Momochiome Hall VGA

Uaing the Spine ffes /nforsction sindos

In the Spine Items tab, the View Info button allows you to open
a Spine [tem Information window so that you can work with the
files assigned to a particular spine item. To open the Spine tem
Information windew, click on a spine item to select it, and then
click View Info. The Spine Item Information windew for the
spine item appears!
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i apme [tem Inloamalson - Chaglean 1 E

Item Descipton II:I--Eq:l:El 1

Eping |been izt
Taiget | SpuceFieMeme | See | OEB Stebus
DERFF- &1 Targeis  [dguidell ocf 5K B
Meonachrome HalvGa  [guideD]_manc, odi 5K
Add Delste Pravisw DEB Check Edt |

¥ Cancel |

This window lists the fallbacks for the selected spine item and
includes the following information:

+ Item Description gives the item description for this spine
itemn from the Spine [tems tab. To change the description,
click in the text box, and edit the text,

« Target displays the build target assigned to each file, Click
on the assigned target to display a list from which you can
select a different build target for the file. I[f you hold your
mouse cursor over the target for a few seconds, Gemstar
eBook Publisher displays the OEB type for the target (for
example, textix-ceb l-document).

+ Spurce File Name lists the name of each OEB document file
assigned to this spine item. If you hold your mouse cursor
over the file name for s few seconds, Gemstar eBook
Publisher displays the full path to the current target file for
that item,

+ Nize lists the size of each QOEB document file, [f you hold
yvour mouse cursor over the size for a few seconds, Gemstar
eBoolk Publisher displays the exact file size in bytes,

1 {36
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« OEE Status shows whether a file has been checked for OEB
coding errors and what kind of errors were found, if any, If
voiul hold your mouse cursor over the status icon for s few
seconds, Gemstar eBook Publisher displays a text description
of the status,

In the Spine [tem Information window, you can also perform the
following actions:

« Click Add to add another fallback file to this spine item. See
the section "Adding fallbacks for spine items" for more
information,

+ Click Delete to delete the selected file, Note that you must
have a file assigned to OEBFF: All Targets, or you will not be
able to save your changes,

+ Click Preview to create o preview of the selected file,

« Click OEB Check to check the OEB coding of the selected
file. The icon in the OEB Status column displays the results of
the recent OEB check, and the window lists details of any
Errors, Warnings, or messages generated by the check,

+« Click Edit to open the selected file in the internal editor or
vour chosen external editor,

Femoving apine ffess
If you need to remove a spine item from a project, you can do
so in three ways:

+ Select the item in the Spine [tems tab, and then press the
Delete key,

+ Select the item in the Spine [tems tab, and then click the
Delete button at the bottom of the tab,

+ Right-click the item in the Spine [tems tab, and then select
Delete from the context menu that appears,

Note that when you remove a spine item from s project, you are
not deleting any files associated with it; you are just remowving
the link to the files from your project. The original files on your
disk are unaffected,
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Working with images

Whenever you display the Images tab in the Project window,
Gemstar eBook Publisher scans the QEB document files
currently listed on the Spine Items tab to find any links to
image files, When it finds such a link, it lists the image file in
the Images tab. To the left of the image file name, it displays a
green or red icon to indicate whether or not it could find the
image file in the specified location.

The immage files in the Images tab are listed in alphabetical
ordet. The order in which they are listed does not affect the

s emdar eBook Publishar - [G: wuide paojectypede, opf]

3B Fle E® Pioject Yiew indow Help =& x|
EoeH& P BE el a2
Build Target: [OEBFF: &0 Taagedz =
E dition Tils: # (Gnada oy The Wiyl Pripleced
E dbian Aulbor Tod Sivara. o o

Spreltens  Imapes | css |

Irwrgee: il M Sipe | T gl | lnage Tpe | wWhiddy | Hesghd | Diepth | =
SUCAY. N 5k (o) DEOFF &0 Taipeis PG 50 & i
bk ki P 4#18  [z] DERFF 20 Taigeds BNl 158 = .
bat_th.prg 1K [ DEBFF A1 Taigeiz FHG 450 160 i o
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You can add fallbacks for image files just as you can for spine
items. For example, if you have a color or grayscale image
farrow.png) in your project, you may want to add a 1-bit
fallback image (arrow mono.png) for the black and white screen
of Monochrome Half-VGA devices, When you add the fallback
image, you do not need to change the image link in yvour OEB
document file, Gemstar eBook Publisher will automatically use
the specified Monochrome Half-VGA fallback image

1 (=T

order in which they are used in the project (unlike spine items),
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arrow_mono.png when you build an eBook Edition for the
Monochrome Half-VGA target,

Fhoozing ieoge fgpes

The Windows and Macintosh versions of Gemstar eBook
Fublisher can work with a variety of immage types, as shown in
the following table:

Image | Windows| Macintosh
type version version
JPG Yes Yes

PNG Yes Yes

GIF Yes Yes

BMP Yes Yes

WhE Yes No

PICT No Yes

Note that WMF (Windows Metafile) images can be used only
with the Windows version and PICT images only with the
Macintosh version of Gemstar eBook Publisher, Animated GIFs
and lossless or progressive JPEGs are not supported.

When you preview or build an eBoolk Edition for the Color VGA,
Grayscale Half-VGA, and Monochrome Half-VGA targets,
Gemstar eBook Publisher first looks to see whether each image
iz in a format native to the target dewvice, I[f not, it locks to see if
the image has a fallback in the native format that it can use.
And if it finds none, then it translates the image (or one of its
fallbacks) into the native image format of the target device,

When you build for OEBFF: All Targets, you are creating an
QEBFF Container, and the OEB specification requires that

there be a PNG or JPEG version of each image — these are
called OEB-compliant images, To meet this requirement,

3
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Gemstar eBook Publisher automatically generates an OEB-
compliant fallback image for any non-compliant image that
does not already have such a fallback. These sutomatically-
generated fallbacks are saved in a folder named "OEB-
Fallbacks” in the same folder as your original imsges,

To keep things simple (and to keep the size of the project down
by eliminating extra images), we recommend that you use PNG
ot JPEG images whenever possihle, If it is not possible
(hecause you are receiving images from an ocutside source, for
example), you still must ensure that all images are in one of the
formats that Gemstar eBook Publisher supports,

Hote When you add OEE document files to a project,
Gemstar eBook Publisher locates the images
raferenced in the files and lists them on the [mages
tab, Any FNG and JPEG images are automatically
aosigned to DEBFF: All Targets, Dther images, such
ax GIFs, are assigned ¢ target of Unknown. You can
change the assigned target as desecribed in the
following sections.

Uzing the feoges faoh

The lmages tab displays the images used for the currently
selected build target, When yvou select a different target from
the Build Target menu, the list of images may change (if you
hawve assigned fallback images, for example),

Sprmliens  Imag | oss |
| Image Fis Hams Sizm Targel Imags Type | ‘Widih | Heighl | Diepth | =
B amow pr 5 [EIOEEFF: Al Targeis PG 50 ez a
Cibacksid: preg 4618  [e5)OEBFF: AN Targeis PHG 155 % 4
Gt siepng 15 [=]JEEFF: Al Tagels PHG 480 168 4

The Images taby has seven columns, which provide the following
information for each image listed:

Image File Name: The Image File Name column displays the file
name for the image, (If you hold your mouse cursor over the
image file name for a few seconds, Gemstar eBook Publisher

en
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displays the full path to the file.) This column also displays a
stnall icon to indicate the status of the file:

The green icon with the circle indicates that the link to
B the imsge file is valid.

. The red icon with the X indicates that the link to the
image file is broken, so the file cannot be found.

Size: The Size column gives the size of the image file. [f you
hold your mouse cursor over the size for a few seconds,
Gemstar eBook Publisher displays the exact size of the file in
bytes.

Target: The Target column lists the build target for the current
image. The icon to the left of the target name is either a single

sheet E to indicate an item with no fallbacks or a stack of
sheets [E to show that the item does have fallbacks,

For OEB-compliant image types that are assigned as primary
images rather than fallbacks, the target displayed will be
OEBFF: All Targets, However, if you have added fsllbacks for
the Monochrome Half-VGA target, for example, then those
fallback images will appear in the Images tab when you select
Monochrome Half-VGA from the Build Target menu, and they
will be listed with Monochrome Half-VGA in the Target column,

Image Type: The lmage Type column lists the type of image:
PNG, JPEG, GIF, and so forth,

Width: The Width column gives the width of the image in pixels,

Height: The Height column gives the height of the image in
pixels,

Depth: The Depth column gives the bit depth of the image: 1 for

1-hit images (2 colors), 8 for 8-bit images (256 colors), and so
forth,
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In the Images tab, you can select a file and click Edit to open
the file in the graphics program registered for this image type.

You can also select a file and click View Info to open the Image
Item Information window for the file, See the following sections,
"Adding fallbacks for images” and "Using the Image [tem
Information windew” for information on using the Image [tem
Information windows,

Hdding follbocks Ffor jmoges

Just a5 you can add fallback OEB document files to a spine
itern in the Spine [tems tab, so you can add fallback images to
any images listed in the Images tab,

To add a fallback for an image file:

In the Images tab, click on an image to select it, and then
click Viesw Info. The Image [tem Information window for that

image appears, listing the image file and any existing
fallbacks,

¢ Imege Inem bifaimabion - C:ugindepiopectomels Theabaaged 'vaiiow_ 1T, psag

| e [t Lt s Frevemm

Tags Tirwes Pl Ploore Sire | Bmbges Topes  Wadh | Heghl | Depls
lnm;m

gt | peee | e e

Click Add to add a fallback file for the image. The Open
dialog appears.

L]
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3 In the Open dialog, locate the image file you want to add
as a fallback, click to select it, and then click Open. The
fallback file appears in the Image [tem Information window,

+ Imege Inem bifoimabion - C:ugindep opectveeds Thes b ged 'vaiiow_ 1T, peag

| arsssgen b Lind Iragm Frevee
Tz | eengys Pl Pl T | Pebgs Teps Wi | Heght | Depds
DEEF 20 T [ s ooy Bl PG ) LE] B

a1 | e | | ] o |
4 Click the target name in the new file's Target column, and

then select the build target for this fallback from the menu
that appears,

Taiget Imags Fle Mams Sze | Imaga Typs | Widh | Height | Deplh |
OEBFF: &1 T aigets ﬁar-:.#.pn; 3K FHG 50 a3 1|
Monochnome Ml G E]ﬂruﬂ_rm:l preg 1K FHG 50 a3 1

Note that yvou must have one file for this imsge assigned to
OEBFF: All Targets, although you can change which file that
is. Also, if you assign more than one file to a particular

L]
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target, Gemstar eBook Publisher will use only the first of the
assigned files and ignore any others for that target,

While the Image Item Information windeow for this image is
open, you can add more fallbacks or edit any image files
already listed, You can also delete any of the fallbacks, but
vou cannot delete the file specified in the link in the OEB
document file i(the first file in the list), See the following
section, "Using the Image [tem Information window,” for
more information,

2 When you've completed your changes, click OK to close
the Image [tem Information windew and save your changes,
ot click Cancel to close the window without saving changes,
Gemstar eBook Publisher returns you to the Images tab,

Sprmlens  mage | oss |

| Image Fis Hams Sizm Targel ImagsType | ‘Widih | Heighl | Ciepth | =
& 5 [EIIEBFF: AN Targels PG 50 g2 2
Eibecksid: peeg 4818 [=]OEBFF: &0 Targel: PG 155 - 4
it cip.png 1K [=]OEBFF: &) Tagels PG 480 168 4

When you use the Build Target menu to select the target you
added a fallback for, you'll see that the file name listed in the
Image File Name column and the target listed in the Target

column change (from arrow.png to arrow_tmono . png and from
OEBFF: All Targets to Monochrome Half-VGA in this

example):
Spemlens  Imag | css |
| Image Fis Hams Sizm Targel Imags Type | ‘Widih | Heighl | Diepth | =
B amow_moere prg 1% [BMorechiome HaFY Tl = B 50 o i
Cibacksid: preg 4618  [e5)OEBFF: AN Targeis PHG 155 % 4
Gt siepng 15 [=]OEEFF: AN Tagels PHG 480 168 4
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Uaing the fmoge ffes /nforsction sindos

On the Images tab, the View Info button allows you to open an
Image Item Information window so that you can work with an
image file and any of its fallbacks. To open the Image [tem
Information windeow, click on an image file to select it, and then
click View Info. The Image [tem Information window for that
image appears!

+ Imege Inem bifaimabion - C:ugindep opectvmels The s s ge s 'vaiiow_ 1T, psag

| e [ s Lt e Frevemm

Tags Tirnps Pl Ploore Sire | Bmades Topes  Wadh | Heghl | Depls
» P T T T R R I
M orecheooas H el SGA5

WO prg 3K 2 JIE] =0 o 1 }

gt | peee | B | Cwm ] o |

This window lists the image file and any fallbacks assigned for
it, and it includes the following information:

« Target displays the build target assigned to each image file,
Click on the assigned target to display a list from which you
can select a different build target for an image file,

+ Image File Name gives the name of the image file, If you
hold your mouse cursor over the image file name for a few
seconds, Gemstar eBook Publisher displays the full path to
the file,

» Nize gives the size of each image file, If you hold your mouse
cursor over the size for a few seconds, Gemstar eBook
Publisher displays the exact size of the file in bytes.

+ Image Type gives the type (PNG, JPEG, etc.) of each image.
+ Width lists the width of each image in pixels,

+ Height lists the height of each image in pixels,

* Depth gives the bit depth of each image,

+ Image Preview shows 2 small preview of the image.

o6
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The icons to the left of each file name indicate whether or not a
file is locked and whether or not it is OEB-compliant. (Image
files that are specifically referenced in an OEB document file
are locked and cannot be deleted.)

The green icon with the padlock indicates that the
Ei image file is locked and is OEB-compliant,

The green icon with the white circle indicates that the
E image file is unlocked and is QEB-compliant,

The yellow icon with the padlock indicates that the
ﬁ image file is locked and is not OEB-compliant,

The yellow icon with the exclamation point indicates
E that the image file is unlocked and is not OEB-
compliant,

. The red icon with the X indicates that the image file
cannot be found,

In the Image Item Information windew, you can also perform
the following actions:

« Click Add to add another fallback file for this image, See the
section "Adding fallbacks for images” for more information,

« Click Delete to delete the selected file, If the file is locked
(because it is specified in an image link in an OEB document
file), you cannot delete it, Instead, you must first edit the OEB
document file so that it no longer links to the image file,

+« C(Click Edit to open the selected file in the graphics program
that is registered in Windows for this type of immage file,




=

L

Gemstar eBook Publisher 2.1 : YWindows User s Guide

Working with style sheets

When vou add OEB document files to a project, Gemstar eBook
Fublisher scans the OERB document files for links to external
style sheets, When it finds a style sheet link, it lists the

corresponding style sheet file in the C55 (Cascading Style
Sheets) tab of the Project windown:

:::;El:rﬂ:lr" ehook, Publidher - | C gt ypicpsd| Yguadas, apl ]
A Be Edl Proect View Mirdow Help =l x|
e - £ * I
el - i GRS A
Build Tapet: [DEBFF A8 T agets |
Editicn Title: # 13ucs ot thas Yatusly Peiplexed
E chinsn Authoi: Tl S, ol
Spin lierm: ] Image: Ls5 ]
[55 Fia Hame irs T st OEE Sisus |
e C5s BB DEBFFE &0 Tages: -
ol coloocee 95H bt V&S o
DOEH Chaeck I | B, I
ey [FaRA | i

Hote The Mornochrome Half-VGA target does not support
style sheets,

The external style sheet files in the C55 tab are listed in
alphabetical order, The order in which they are listed does not
affect the project in any way (unlike spine items),
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Uaing the L5855 fah

The CS8 tab displays all the external style sheets referenced in
any of the OEB document files in the project, Unlike the Spine
Items and Images tabs, the C55 tab does not change when you
select a different build target,

Sprw lams | Trmazpecs Cs5 |
=5 Fils Mams Cize Targei OEE Siatus
ouice. pss BEE  OEDFF: &0 Targets !-"
ouide_colmoss GE Color WGES e

The C55 tab has four columns, which provide the following
information for each external style sheet listed:

CSS File Name: The CSE File Name column lists the names of
any style sheet files referenced in the project’'s QEB document
files,

Size: The Size column gives the size of the file,

Target: The Target column lists the target to which each style
sheet file has been assigned, as described in the following
section, "Adding style sheets for different targets.”

OEB Status: The OEB Status column shows whether the file's
OEB coding has bheen checked, and if so, whether any errors
were found, The column displays one of the following four
icons:

The yellow icon with the question mark indicates that
E the file has not yet been checked for errors,

The green icon with the check indicates that the file
has been checked and found to have no warnings or
EITOrs,

The yellow icon with the exclamation point indicates

E that the file has been checked and found to hawve
warnings and errors, See the Errors and Messages
window for details,

L]
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The red icon with the slashed circle indicates that the

2 file has fatal errors that prevent the building of an
eBook Edition, SBee the Errors and Messages window
for details,

In the OS5 tabk, yvou can also select a file and perform the
following actions:

« Click QEB Check to check the OEB coding of the selected
style sheet file,

+« Click Edit to open the selected file in the internal editor or
vour chosen external editor,

Hdding styfe sheefz Ffar differenft faorgefs

You cannot directly add fallbacks for external style sheets in
the way you can for spine items and images, However, in the
link tag that you add to your OEB document files to link to the
external style sheets, you can change the type attribute to
specify that a style sheet is to be used for a particular target,
You can use the following type attributes:

Target Type atiribute

OEEBEFF: All text/x-oebl-css

Targets (text'css is also walid)

Color VGA text/x-gemstar-vga-css

Grayscale Half- text/x-gemstar-halfwga-gray-css

ViGA

Monochrome Half- | None: This target does not support style
ViGA sheets,

For example, if you have a style sheet file named guide.css to
use for QEBFF: All Targets, yvou would link to it as follows:

L]




=

L

Gemstar eBook Publisher 2.1 : YWindows User s Guide

<link href="guide.css" type="texi fx—oebl-c=s":

If you wanted to use a different style sheet named
guide color.css for Color VGA devices, then you would add s
second style sheet link to your OEB document, as follows:

ilink href="guide_color.css" type="text fx—gemstar—uwga-css"r

When yvou preview ot build an eBook Edition, then, Gemstar
eBook Publisher uses the style sheet sppropriate to the target
voiu've selected,

Checking for errors

After you've crested a project and added your OEBE document
files to the Spine [tems tab, you can check for OEB coding
problems in the entire project or in selected spine items only,
During an OEB check, Gemstar eBook Publisher checks the
OEB document files that would be used for the currently
selected target (sccording to the Build Target menu), plus any
external style sheets used by those files,

Fhocking Fifea far errorz
To check an entire project for errors:

1 In the Project window, select the appropriate target device
from the Build Target menu.

2 To start an OEB check for the entire project, click the

OEB Checlk All button ﬁ on the toolbar at the top of the
Project window, or select OEB Check All from the Project
menu, Gemstar eBook Publisher begins checking all the OEB
document files for the currently selected target,

3 When the checlk is complete, Gemstar eBook Publisher
displays the Errors and Messages window, which lists all
etrors in the project’'s OEB document files, in the order they
were encountered,

=l
[}
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To check individual files for errors:

1 In the Project windeow, click the Spine [tems tab to bring it
to the front, and then select the appropriate target device
from the Build Target menu,

2 Select one or more spine items, You can control-click or
shift-click to select multiple items,

3 Click the OEB Check hutton _OEE Creck | at the bottom of the
Spine [tems tab, Gemstar eBook Publisher begins checking
the selected OEB document files and displays a progress
dialog while it works,

4 When the checlk is complete, Gemstar eBook Publisher
displays the Errors and Messages window, which lists any
errors in the order in which they were found.

Hote You can also check individueal files for errors by
usirng the OELR Check buttonr in the Spine [tem
Information window, as described in the earlier
gection "Using the Spine ltem [nformation window.”

You can use this same method to check the OEE coding of
external style sheet files in the CSS tab, Style sheet files are
also checked sutomatically when the OEB document files that
link to them are checked (either individually or in a project-
wide check),
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fdenfifying fypes af errors ond se3szogges

The Errors and Messages window displays three types of error
tmessages, each identified by its own icon:

Fatal Errors: These errors prevent the previewing or
. building of an eBoolk Edition and must he corrected.

Errors: These errors don't prevent the previewing or
EE building of an eBook Edition but may adversely affect its
appearance, They should be corrected.

Messages and Wamings: These non-error messages or

A watnings don't prevent the previewing or building ef an
eBook Edition and may not affect its appearance, We
recomimend that warnings be corrected.

If the Errors and Messages window is not visible, select Errors
and Messages from the Window menu to display it.

Farrect ing errors

If Gemstar eBook Publisher identifies errors in your OEB
document files, you can correct the errors using either
Gemstar eBook Publisher's internal editor or the external
editor of your choice, (See "Setting preferences” earlier in this
guide for information on cheoosing your editor.) Correct all

errors and fatal errors before you attempt to create a final
eBoolk Edition,

To correct errors identified by Gemstar eBook Publisher:

1 In the Errors and Messsges window, double-click the text
of the first error you want to correct,

If you're using the internal editor, Gemstar eBook Publisher
opens the appropriate OEB document file in the editor and
then positions the cursor on the line containing the error so
that you can find it easily.

If you're using an external editor, Gemstar eBook Publisher
simply opens the appropriate OEB document file in your

L]
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editor. Use the line number given in the Brrors and Messages
window to locate the error,

Hote Some external editors can "soft wrap® lines of text to
g width you choose, With soft wrap on the line
numbers in the editor may not mateh the line
numbers given in the Errors and Messages window,

Turn the editor's soft wrapping off to avoid this
problem,

In the editor windeow, correct the error and save your
changes,

Select the Errors and Messages window again, and then
double-click the next error, Gemstar eBook Publisher

dispplays the next error in the editor window so that you can
correct it,

Repeat these steps to work through the list of errors in
the Errors and Messages window,

As you make corrections in the editor window, the number of
lines in the file may change, If so, the line numbers in the
Errors and Messages window may no longer be accurate, To

refresh the accuracy of the line numbers, run an OEB Check
on the file again,

When yvou're done, save the changes in the editor, return
to the Spine [tems tab, and check the file again, If you've
cotrrected all the errors, a green icon with a checkmark
appears in the OEB Status column,

Tip A single error can sometimes produce @ cascade of
other errors through the file. [f your file shows many
errors, start at the beginning, correct the first few
grrors, and then go to the Spine [tems tab and checkk
the file again, You may find that later errors
disappear as you correct the early ones,

3
H
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Uaing the ipfterpal edifor

If you hawve a favorite text or HTML editor, you can configure
Gemstar eBook Publisher to use it sutomatically when you edit
OEB document files to correct errors. (See "Setting
preferences” earlier in this guide for more information.)

If you don’t specify an external editor in Gemstar eBook
Publisher's preferences, then Gemstar eBook Publisher uses its
internal editor to open OEB document files when you double-
click an error in the Errors and Messages window or when you
double-click a file name in the Project windowr,

This internal editor includes standard Windows mouse and
keyboard commands for text editing plus some adwvanced
features such as syntax coloring, auto-indenting, enhanced
find/replace, navigation commands, and drag-and-drop editing,

Click to Click to Emter a lime number,
previews  check this and press Enter 1o
this file.  file again. jump te a line.
u ';pl-:-.r.-r.-l'-.mulr.-r.-'..gmdr.—l] dl ==1El
B_ 5|  LiomHu=: [
<HY¥ ALIGH="LEFT":> IpeEning & Book<,HI:= ;I
. _ <P VSPACE="7¥»wOL>
Click or click- — 112 4frer opening your SoftBook, press che Bookshelf bucton of
ﬂﬂd'dr&rj 1y P VEPACE="7Y#<1TrLook chrough che Llist of books stored in yoo
laft mar-gl'n <P VEFACE="7":IHE BFC="imapes / 0o0Xncry . Jif"™ ALIGHN="NIDDLE™ WI
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Hote To open an OEE document file for editing in Gemstar
eBook Publisher, double-click the file name in the
Spine [tems tab, The Open command on the File
menu opens only project files (opfor spf), eBook
Edition files {imp or .rb), and OEBFF Container files
{.oeb),
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Creating a new file in the intemnal editor

If you want to create a new, blank, OEB document file, choose
New Text Document from the Gemstar eBook Publisher's File
menu, The internal editor opens & new window (even if you have
selected an external editor in the Preferences).

You can enter text and OEB coding into this window either by
typing directly or copying and pasting from another window,
You can also use the OEB Check and Preview commands on
this new file, even if you have not yet added this new document
to a project,

To save the new file, choose Save from the File menu, or press
Ctrl-5. You will be promypted to select a name and location for
the file,

If you have a project open, you will also be asked if you want to
add this new file to the project, Click Yes to add the file to the
project or No to sawve the file without adding it to the project.

Duplicating a file in the intemal editor

If you want to duplicate one of the OEB document files in a
project — so that you can experitment on the copy without
affecting the original, for example — double-click the file in the
project window to open it. Then choose Save As from the File
tmeny, and select a new name andlor location for this copy of
the file, Once the file is saved with a new name or location, then
any changes you make to it will not affect the original file,

If you choose a file name that does not yet exist in the project,
voiul will be asked whether vou want to add the file to the
project, Click Yes to add the file to the project.,

If you enter a name and location that match an existing file in
the project, you will be asked whether you want to replace the
existing file, Click Yes to replace the existing file or No to
return to the Ssve As dialog so that you can select s different
name or location,

L]
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Freviewing the project

After you checlk the files for errors and correct any that
Gemstar eBook Publisher finds, you can mowve on to the next
stepy — previewing your files to see how they'll lock on a
Gemstar eBook, You can preview the entire project or a2 single
spine item, and you can preview for Color VGA, Grayscale Half-
VGA, or Monochrome Half-VGA devices, (Note that if you
previesw the entire project, the links within the files become
active, [f you preview individual files, the links do not show)

The Gemstar eBook Publisher Preview window gives you an
accurate simulation of your eBook Edition’s sppearance,
including color, page size, aspect ratio, fonts, spacing, and
other formatting features. Using the preview, you can spot any
display problems and optimize yvour project for each target
device,

Hote Although Gemstar eBook Publisher lists OEBFF; All
Targets as one of its targetls, you cannot preview for
thiz target — it does not represent an actual reading
device ag the other targets do, [nstead, DEBFF; All
Targets represents an OEBFF Container, a standard
package of all the files, fallbacks, and other
information required to build an eBook Edition. [tis
intended to be processed by back-end systems that
will render it into a form suitable for a specific
reading device,

Freviering pages
To preview a spine item or an entire project:

1 From the Build Target menu, select the target device
(Color VGA, Grayscale Half-VGA, or Monochrome Half-VGA)
that you want to create a preview for,

2 To preview the entire project, click the Preview Edition

button & on the toolbar at the top of the Project window, or
select Preview Edition from the Project menu.

1 TE L]
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To preview a single item, click the Spine Items tab to bring it
to the front, click on the spine item to select it, and click the

Fresrieswsr button m at the bottom of the tab, (You can
control-click or shift-click to select multiple items.)

3 Gemstar eBook Publisher displays a Preview Progress
window while it's building a preview of the file, When the
previesw is complete, Gemstar eBook Publisher opens the
appropriate Viewer (Color VGA, Grayscale Hali-VIGA, or
Monochrome Half-VGA) and displays the first page,

L]
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Using the Color VGA Viewer

Click to mowe back
ar forward one page.

Click to seleck

color or grayscale.
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Highlighting
Text in a Book

While you're reading a boole on your SoftBook, yon can

adding brief notes or deawinge, This ¢l

ter e the Hillte tool to nlgmi-gm tent. The fellowing teo
chapters explain how to use the Deaw tool for notes and
rlups.

o b S e

mark up pages by highlighting interesting passages and by
rexplaing how

|
Crrag the Page Slider to
mave through the pages.

The

Color VGA Viewer emulates the display of & Color VGA reading
device and provides some of the features of those dewvices:

In the Viewer, vou can navigate through the pages with the

following buttons and comimands:

+ (Click the First Page button @ ot press the Home key to
mowve to the first page, (You can also choose First Page from

the Viessr menu.)

* Press the End key
choose Last Page from the View menu.)

to mowe to the last page. (You can also

7a a5
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+ Click the Next Page button ) press the Page Down key. or
type N to mowve to the next page, (You can also choose Next
Page from the View menu.)

« Click the Previous Page button .iﬂj, press the Page Up key, or
type P to mowve to the previous page. (You can also choose
Prew Page from the View menu.)

+ Type apage number in the Page Number box, and then press
Return to jump to a specific page. (You can also type Control-
& or choose Go to Page from the View menu to open the Go
to Page dialog.)

+ Drag the Page Slider to the page you want,

You can also use the following commands in the Viewer:

+ Click & or type Z to zoom to the large view or back to the
regular view, You can also choose Zoom from the View menu,

+ Click the Target menu I = to switch between color and
grayscale previesss,

+ Click the Information button ¥ to display an Information
slip for this eBook Edition, You can also choose eBook
Edition Information from the View menu,

+ Click the upper right corner of 2 page to bookmark it. A+
mark sappears on the Page Slider bar to mark the spot, Click
that + mark to return to the bookmarked page.

« Click a word on the page to use the Select tool from the Pen
Palette to find other occurrences of the word or glossary
entries if you've added a glossary. (Other Pen Palette tools
aren’t active in the Preview window.)

Using the Grayscale Half-VGA Viewer

The Grayscale Half-VGA Viewer emulates the display of a
Grayscale Half-VGA reading device, provides some of the
features of that device, and is almost identical to the Color VGA
Viesser just described, with these exceptions:

3
v
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+ Thewindow is smaller, reflecting the smaller screen size of
Hali-VGA devices,

+ The preview is grayscale only, not color,

+ There iz no Target menu to switch between color and
grayscale previesws,

In all other respects, the Grayscale Half-VGA Viewer works just
like the Color VGA Viewer, including the navigation buttons and
other controls, Please see the description of these items in the
previous section, "Using the Color VGA Viewer.”

Using the Monochrome Half-VGA Viewer

The Monochrome Half-VGA Preview window emulates the
display of a Monochrome Half-VGA reading device and provides
some of the features of that dewice. Like the dewvice itself, the
preview lacks some features found in Color VGA devices and
includes a unigque feature of its own (a Rotate button to switch
betaeen portrait and landscape display),
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+ Click the First Page button B oy press the Home key to
move to the first page, (You can also choose First Page from
the Viewr menu.)

+ Press the End key to move to the last page. (You can also
choose Last Page from the View menu.)

+ Click the Next Page button @, press the Page Down key. or
type N to mowve to the next page, (You can also choose Next
Page from the View menu.)

+ Click the Previous Page button g, press the Page Up key, or
type P to mowve to the previous page. (You can also choose
Prew Page from the View menu.)

+ Click the scroll bar to move to the page you want,

You can also use the following commands in the Viewer:
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+ Click 2| or type Z to zoom to the large view or back to the
regular wiew, You can also choose Zoom from the View menu,

+ Click the Information button ¥ to display an Information
slip for this eBook Edition, You can also choose eBook
Edition Information from the View menu,

+ Choose Landscape or Portrait from the View menu to switch
the display between landscape and portrait mode, (You can
also type L for landscape mode or B for portrait mode.)

Farrecting previes prabhloes

As you preview your files, you're likely to spot design or
formatting problems that need to be fixed (bad page breaks,
images that need to be resized or repositioned, design or
formatting elements that don't work as you thought they would,
and so forth), Edit the appropriate OEB document file (or image
file, if necessary) to correct these problems, save the ypdated
file, and then preview the file again to see the resulis,

To correct problems found in the Viewer:

1 Return to the Spine [tems tab in the Project window, and
double-click the file that you want to edit. Gemstar eBook
Publisher opens the file in your chosen editor,

2 Malke any necessary changes in the file,

3 Previewr the file or project again to view your changes, (If
vou're using the internal editor, just click the Previesr button
to preview the file you're editing.)

Continue checking the pages in the Viewer for problems,
repeating steps 1 through 3 as needed to correct them,

4 When yvou've finished making changes to a particular file,
save it, Then return to the Spine Items tab, and check the file
for errors again to make sure that you haven't introduced any
NEW ONes,

After vou've previewed and corrected all the individual files, you
should slso preview the project as a whole, To do so:
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1 In the Project window, click the Spine Items tabk fo bring it
to the front, and select the proper target device (Color VGA,

Grayscale Half-VGA, or Monochrome Half-VGA) from the
Build Target meni,

2 Click the Previewr Edition button at the top of the Project
window, or choose Preview Edition from the Project menu,
Gemstar eBook Publisher builds a preview of the entire
project and displays it in the Viewer,

In addition to looking for design and formatting problems
once again and checking all the links within the book, make
sure that all parts of the eBoolk Edition are present (including
the cover, title page, copyright page, and table of contents, if
required), that they are arranged in the proper order, and
that they flow together properly.

Building an OEBFF Container or eBook Edition

The final step is to build an OEBFF Container or eBoolk Edition,
creating the final files that vou will distribute, Before taking
this step, check the following list to make sure that your
project is ready to build,

+  All QEB document files required for the project are listed in
the Spine [tems tab of the Project window and arranged in the
order in which they should appear.

+« All OEB document files have bheen checlked and have no
errors ot fatal errors,

« All files have been previeswed in the Preview window for each
of the desired targets,

+ No extraneous items are listed in the Spine [tems tab of the
Project windowr,

+« All image files are present in the proper folders and are in
the proper graphic format (FNG, JPEG, GIF, WMF, or BMP),

+ The information in the Edition Settings window — including
the I, author, title, and category — is correct and complete,

To build an OEBFF Container or eBook Edition:
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1 In the Project window, select the desired target from the
Build Target menu, Choose!

« QEBFF: All Targets to build an QEBFF Container file,

+ Color VGA to build .imp and key files for Color VGA

devices, including the REB1200, SoftBook Reader 250e,
and SoftiBoolk Reader 200,

» Grayscale Half-VGA to build .imp and .key files for
Grayscale Half-VGA devices,

+ Monochrome Half-ViGA to build a .rb file for
Monochrome Half-VGA devices, including the REB1100,
Roclket eBook, and Rocket eBoolk Pro.

2 Click the Build Edition button at the top of the Project
window, or choose Build Edition from the Project menu. (If
voiul have not filled out all the required Edition Settings
information, the Edition Settings window how appears so
that you can enter the information.)

3 If you specified an output folder in the Edition Settings
window, Gemstar eBook Publisher immediately begins to
build the eBook Edition,

If you didn't specify an cutput folder, the following Browse
for Folder dialog asppears. Select the folder where you want
the final files placed, and click OK, Gemstar eBoolk Publisher
begins to build the eBook Edition,
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4 If Gemstar eBook Publisher encounters any errors in the
build, it displays them in the BErrors and Messages window, If
it completes the build successfully, it plays the "Success”
sound (if you selected one).

Onece the build is complete, you'll find the resulting files in the
specified cutput folder. For example, if you selected OEBFF: All
Targets and built an OEBFF Container (.oeb), you'll find the
following file in the cutput folder:

+ guide.oeb: This MIME-encoded file contains the project file,
all OEB document files, and all image files, including
automatically generated OEB-compliant fallbacks, if needed, It
does not contain .imp, key, or .th files, [f you selected the
Encrypt and Compress options, any eBook Editions created
from the .oceb file will be encrypted and compressed,
Howeser, the .cehb file itself is not encrypted or compressed,

If you built an eBook Edition for Color VGA or Grayscale Half-
VIGA dewvices using the file name guide, you'll find the following
files in the cutput folder:
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+« guide.imp: This file contains all of the content in a single file
that may also be encrypted and compressed depending on the
output options you chose,

+ guide. key: This file contains the encryption key, [fyou
selected the encryption option, this file must be present to
open the eBook Edition, If you did not select the encryption
opption, this file is not created,

If you built an eBook Edition for Monochrome Half-VGA
devices, you'll find the following file in the cutput folder:

+« guide.rh: This file contains all of the content in a single file,
If you selected the Encrypt and Compress options, the eBook
Edition will be encrypted and compressed when it is
published through the back-end distribution system.
However, the b file itself will not be encrypted or
compressed,

Tip Choose Open from Gemstar eBook Fublisher's File
menu (or press Cirl-0) and then select the completed
Jdmp, vl or oeb file to preview it

Editing or previewing an OEBFF Container

If you have created or have received an OEBFF Container file,
vou cannot alter the content or the formatting in the QEBFF
Container. Howewver, you can edit the publication information
(title, author, ISBN, and so forth), and you can preview the file
for any of the preview targets, (To alter the content or
formatting, you must unpack the OEBFF, malke your changes to
the extracted project files, and then build a new QEBFF
Container,)

To edit or preview an OEBFF Container:

1 Choose Open from Gemstar eBook Publisher’s File menu,
The Cpen dialog appears,

2 In the Open dialog select the QEBFF Container file and
click Open. The Settings window for the OEBFF Container
sppears.

L]




=

L

3

Gemstar eBook Publisher 2.1 : YWindows User s Guide

DEBFF Container Settings i
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[k -
Save Unpack. | Cancel

To edit any of the publication information, click the
appropriate tab (Edition Info, Description, Identifiers,
Bookstore, Pricing, Build Options) to bring it to the front,
and then add or change the information as required. The
information displayed here is the same as that displayed in
the Edition Settings window for a project. S8ee "Entering the
project information” earlier in this guide for s complete
description of the tabs and all their options,

To preview the OEBFF Container, select a target from the
Previessr Target menu (Color VGA, Grayscale Half-VGA, or

Monochrome Half-VGA), and click the Preview button [&,
Gemstar eBook Publisher builds a preview for the selected
target and displays it in the Preview window, See "Previewing
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pages” earlier in this guide for a complete description of how
to use the Preview windows, Note that, as necessary, the
preview will use any updated values in the Edition Settings
dialog.

2 Te unpack the QEBFF container, press the Unpack button,
Refer to the details of unpacking OEBFF containers in the
next section,

Unpacking OEBFF Containers

Onece you have loaded an OEBFF container into the application
and are looking at the Edition Settings for the file, you can elect
to unpack the container onto your system. Unpacking means
extracting the project file and every document file, external CS58
file, immage file, etc, and saving them to an appropriate location
O ¥our system,

The unpacked project file will include all modifications that you
thay hawve made in the Edition Settings dialog before pressing
the unpack button,

You should note that onee you unpack an OEBFF container,
any changes made to the project and/or documents, images,
etc. do not affect the original OEBFF container. If vou wish
changes to be made in OEBFF then you must rebuild the
OEBFF container from the project file,

To unpack, follow this procedure:

1 Press the Unpack button at the bottom of the Edition
Settings dialog.
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2 I¥ou are asked
where to save the project file that will be extracted from the
OEBFF container, This is done with a customized version of
the standard system Save As dislog box as shown here,

3 Browse to the location you wish the nesw project file to be
stored in and enter the desired filename, The original project
filename will be presented as a default,

4 Choose whether or not you want to automatically
overwrite any files that may already exist in your system,
Once the project file has been extracted the remaining files
will be extracted and saved sccording to how they are
specified in the project. Files that are specified with relative
paths (highly recommended!) will be extracted and saved to
the same corresponding relative path in your file system. Any
subfolders will be created automatically during this process,
Files that are specified with absolute paths will be extracted,
if possible, to that same absolute path, Once the location for
a file being extracted has been determined the unpacking
procedure looks to see if there is already a file there with the
same name, [f so then checking this option (the default) will
overwrite that existing version of the file with the version
extracted from the QEBFF container. If you remove the check
from this option and a file with this name already exists it
will be left alone - you will not be prompted to overwrite,
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2 Choose whether or not you want to automatically load the
resulting project into Gemstar eBoolk Publisher after the
unpack operation finishes so that you can begin editing it as
a normal project. If checked (the default) a new Gemstar
eBoolk Publisher main window will be opened and the newly
unpacked project will be loaded into it, The original
application window is still open and still viewing/editing the
OEEBFF file you just unpacked,

What to do with yvour finished project

Onece yvou've successiully built your eBook Edition or OEBFF
Container, you can submit it for publication. You will need to
submit the final eBook Edition or OEBFF Container files you've
created, but you may also need to submit the project file, your
original source files, and possibly auxiliary files such as a cover
image as well, Contact the person, department, or company
responsible for publication to find out what the proper
submission procedure is and which files you must submit,

—
[N}
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Appendix A: BISAC codes

The BISAC (Book Industry Systems Advisory Comuimnittee) codes
define the subject headings under which a book should be
listed, The following table lists the codes for the 48 top-lewvel
subject headings, Note that esch code consists of three letters
followed by six numbers, For the top-level subject headings, the
six numbers are always 000000,

The complete list of BISAC codes, which covers the 48 top-level
subject headings and over 3,100 subheadings, is published by
the Book Industry Study Group under the title BISAC Subject
Headings, You can purchase this publication in print or
electronic form through the Book Industry Study Group web
site at httpeanar bisg org,

Code Subject heading

ANTODDOOO |Antiques & Collectibles

ARCO00000 [Architecture

ARTOOO0DD |Art

BIOO0O0O000 |Biography &
Autohiography

CC000000 |Body, Mind & Spirit

EUS000000 |Business & Economics

CoOMO00000 | Computers

CKEBOOODOO |(Cooking

CRAQOO0OOQQ |Crafts & Hobbies

CUROOOOO0 |Current Events

DERAQOOQOOD | Drama

)
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EDUO0000O0

Education

FAMOOOOOO

Family & Relationships

FIC000000

Fiction

FOROOOOODO

Foreign Language Study

CAMODOOOO

Games

GARQODOOO

Gardening

HEAQOQOOQOQOQ

Health & Fitness

HISO00000

History

HOMODOO0OO

House & Home

HUMODODOOO

Humeor

JUY000000

Juvenile Fietion

JNFOOOOO0

Juvenile Nonfiction

LANDOOOOQD

Language Arts &
Disciplines

LAWO0DDOO

Lasar

LITOOOO0O

Literary Criticism &
Collections

MATOODOOO

Mathematics

MEDOOOO00

Medical

MUS000000

Music

NATOOOOOD

Nature

L]




=

L

Gemstar eBook Publisher 2.1 : YWindows User s Guide

PEROOOOQOO

Performing Arts

PETOOOOOO

Pets

PHIOOOOOO

Philosophy

PHOOODOOO

Photography

POEQOOODD

Poetry

POLOOOOOD

Folitical Scietice

PSYOO0O0OO0

Psychology & Psychiatry

REFO0OO0OQQO

Eeference

RELOOOOOD

Religion

SCI000000

Scietice

SELOOOOON

Self-Help

SCOC000000

Social Science

SPO00000O0

Sports & Recreation

STUDOOOO00

Study Aids

TECOOOOOO

Technology

TRADOOOOD

Transportation

TRYVOOO0000

Trawvel

TRUOOOO00D

True Crime

2
H
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Appendix B: Country and currency

codes

The following table lists the three-letter country and curtrency
codes that vou can currently use in Gemstar eBook Publisher,

These codes are taken from the much larger standards

published by the Internationsal Organization for Standardization
(IS0 IS0 3166 for country codes and [S0 4217 for currency
codes. You may purchase the official [S0 publications of the

complete standards through the IS0 web site at
httpiamamerizo.org.

Country Country Currency Currency Code
Code

Austria AUT Euro EUR

Belgium EEL Euro EUR

Canadsa CAN Canadian CAD
Dollar

China CHN Yuan CNY
Renminhbi

Denmark DNK Euro EUR

Finland FIN Euro EUR

France FRA Euro EUR

Grermany DEU Eureo EUR

I[taly ITA Eureo EUR

Japan JPN Yen JPY

Netherlands [(NLD Euro EUR
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Norway NOR Euro EUR
Spain ESP Euro EUR
Sweden SWE Euro EUR
Switzerland |CHE Swiss Franc (CHF
United GBR UK Pound GBP
Kingdom

United States (USA US Dollar usD
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